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The pivot table is the single most powerful com-
mand in all of Excel. Pivot tables came along during 
the 1990s, when Microsoft and Lotus were locked 
in a bitter battle for dominance of the spreadsheet 
market. The race to continually add enhanced fea-
tures to their respective products during the mid-
1990s led to many incredible features, but none as 
powerful as the pivot table.  

With a pivot table, you can transform one million 
rows of transactional data into a summary report in 
seconds. If you can drag a mouse, you can create a 
pivot table. In addition to quickly summarizing and 
calculating data, pivot tables enable you to change 
your analysis on the fly by simply moving fields 
from one area of a report to another.  

No other tool in Excel gives you the flexibility and 
analytical power of a pivot table.      

  What You Will Learn from This Book  
It is widely agreed that close to 60% of Excel users 
leave 80% of Excel untouched. That is, most users 
do not tap into the full potential of Excel’s built-
in utilities. Of these utilities, the most prolific by 
far is the pivot table. Despite the fact that pivot 
tables have been a cornerstone of Excel for almost 
20 years, they remain one of the most underutilized 
tools in the entire Microsoft Office suite.  

Having picked up this book, you are savvy enough 
to have heard of pivot tables—and you have perhaps 
even used them on occasion. You have a sense that 
pivot tables provide a power that you are not using, 
and you want to learn how to leverage that power to 
increase your productivity quickly.  

Within the first two chapters, you will be able to 
create basic pivot tables, increase your productivity, 
and produce reports in minutes instead of hours. 
Within the first seven chapters, you will be able to 
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output complex pivot reports with drill-down capabilities and accompanying charts. By the 
end of the book, you will be able to build a dynamic pivot table reporting system.   

  What Is New in Excel 2016’s Pivot Tables  
Luckily, Microsoft continues to invest heavily in business intelligence (BI), and pivot tables 
are the front end that let you access the new features. Some of the features added to Excel 
2016 pivot tables include the following:  

    ■   Pivot tables now provide auto grouping for date or time columns. If you add a date 
column to the Rows or Columns area, Excel will automatically group the data up to 
Months and collapse to Months. If the data spans more than one year, Excel will add 
Quarters and Years as well. If you add a time column, Excel will automatically group to 
Seconds, Minutes, and Hours and collapse to show only the top level.   

   ■   Pivot charts offer expand and collapse buttons. If you add two or more fields to the 
Axis or Legend area of a pivot table, you can use the + and − icons on the pivot chart to 
zoom in and out on the hierarchy.   

   ■   Slicers now offer a Multi-Select icon to allow you to choose multiple items without 
using the Ctrl key. This feature was added for touchscreens.   

   ■   If your data has a geographic field such as for addresses or postal codes, you can build a 
pivot table on a map by using the 3D Maps icon on the Insert tab.   

   ■   If you need to import data for a pivot table, the Power Query tools found under Data, 
Get & Transform will assist you in cleaning and shaping that data.   

   ■   Power Pivot has an automatic feature for creating a calendar table.   

   ■   If you select Insert PivotTable from a blank cell, and if there is a Data Model in the 
workbook, Excel will offer to build the pivot table from the model.   

   ■   Power Pivot’s Auto-Detect Relationships dialog offers a Manage Relationships button 
that allows you to review or correct any relationship that was detected.    

 If you skipped right over Excel 2013, you may not know about some of the new features it 
introduced. Here are some of the best ones:  

    ■   Beginning with 2013, Excel offers thumbnails for 10 recommended pivot tables when 
you choose Insert, Recommended Pivot Tables. If you are not sure how best to summa-
rize your data, you’ll find plenty of inspiration in this dialog.   

   ■   A timeline slicer enables you to easily filter a pivot table by month, quarter, or year.   

    ■   Excel 2013 introduced the Data Model as a way to build a pivot table from two tables. 
This is for the versions of Excel that do not offer Power Pivot.   

   ■   People using Office Professional Plus, Office 365 Pro Plus, or other high-end editions 
can enable the Power Pivot add-in. Power Pivot provides drag-and-drop functionality to 
link tables, worksheets, SQL Server, and more. Power Pivot adds better calculated fields.   

   ■   Power View enables you to animate pivot tables in an ad hoc query tool.     



3Skills Required to Use This Book

  Skills Required to Use This Book  
This book is a comprehensive enough reference for hard-core analysts yet relevant to 
casual users of Excel. The bulk of the book covers how to use pivot tables in the Excel user 
interface.  Chapter   10   , “Mashing Up Data with Power Pivot,” delves into the Power Pivot 
window.  Chapter   14   , “Advanced Pivot Table Tips and Techniques,” describes how to  create 
pivot tables in Excel’s powerful VBA macro language. Any user who has a firm grasp of 
basics such as preparing data, copying, pasting, and entering simple formulas should not 
have a problem understanding the concepts in this book.      

 Say that your manager asks you to create a one-page summary of a sales database. He would like to see total revenue by 

region and product. Suppose you do not know how to use pivot tables. You will have to use dozens of keystrokes or mouse 

clicks to complete this task.  

 First, you have to build the outline of the report:  

1.   Copy the Product column to a blank section of the worksheet.   

2.   Select Data, Remove Duplicates to eliminate the duplicates.   

3.   Delete the Product heading.   

4.   Copy the unique list of products and then use Paste Special Transpose to turn the list sideways.   

5.   Delete the vertical list of products.   

6.   Copy the Region column to a blank section of the worksheet.   

7.   Select Data, Remove Duplicates to remove the duplicates.   

8.   Delete the Region heading.   

9.   Cut and paste the products so they appear left of and below the regions.    

 At this point, with 27 mouse clicks or keystrokes, you’ve built the shell of the final report, but there are no numbers inside 

yet (see  Figure   I.1   ).   

 Next, you need to build the relatively new SUMIFS function to total the revenue for the intersection of a region and prod-

uct. As shown in  Figure   I.2   , the formula =SUMIFS($G$2:$G$564,$C$2:$C$564,L$1,$B$2:$B$564,$K2) does the trick. It 

takes 52 characters plus the Enter key to finish the formula, but I managed to enter the formula in 36 clicks or keystrokes 

by using some clever navigation tricks I’ve learned over the years.   

 C A S E  S T U D Y :  L I F E  B E F O R E  P I V O T  T A B L E S  

Figure I.1  
 It took 27 clicks to get to 
this point.        
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  Invention of the Pivot Table  
When the actual pivot table was invented is in dispute. The Excel team coined the term 
pivot table , which appeared in Excel in 1993. However, the concept was not new. Pito Salas 
and his team at Lotus were working on the pivot table concept in 1986 and released Lotus 
Improv in 1991. Before then, Javelin offered functionality similar to that of pivot tables.  

The core concept behind a pivot table is that the data, formulas, and data views are stored 
separately. Each column has a name, and you can group and rearrange the data by dragging 
field names to various positions on the report.      

 If you are adept at using the fill handle, you need just two more mouse drags to copy the formula to the rest of the table.  

 Enter the heading Total for the total row and for the total column. You can do this in nine keystrokes if you type the first 

heading, press Ctrl+Enter to stay in the same cell and then use Copy, select the cell for the second heading, and use Paste.  

 If you select K1:P6 and press Alt+Equals, you can add the total formulas in three keystrokes.  

 With this method, which takes 77 clicks or keystrokes, you end up with a nice summary report, as shown in  Figure   I.3   . If 

you could pull this off in 5 or 10 minutes, you would probably be fairly proud of your Excel prowess; there are some good 

tricks among those 77 operations.   

 You hand the report to your manager. Within a few minutes, he comes back with one of the following requests, which will 

certainly cause a lot of rework:  

    ■   Could you put products down the side and regions across the top?   

   ■   Could you show me the same report for only the manufacturing customers?   

   ■   Could you show profit instead of revenue?   

   ■   Could you copy this report for each of the customers?    

Figure I.2  
 If this were the year 
2006, the SUMIFS func-
tion would have been 
an uglier SUMPRODUCT 
function.        

Figure I.3  
 A mere 77  operations 
later, you have a 
 summary report.        



5Invention of the Pivot Table

 Say that you’re tired of working so hard to remake reports every time your manager wants a change. You’re in luck: You 

can produce the same report as in the last case study but using a pivot table. Excel 2016 offers you 10 thumbnails of rec-

ommended pivot tables to get you close to the goal. Follow these steps:  

1.   Click the Insert tab of the ribbon.   

2.   Click Recommended PivotTables. The first recommended item is Revenue by Region (see  Figure   I.4   ).    

3.   Click OK to accept the first pivot table.   

4.   Drag the Product field from the PivotTable Fields list to the Columns area (see  Figure   I.5   ).    

 C A S E  S T U D Y :  L I F E  A F T E R  P I V O T  T A B L E S  

Figure I.4  
 The first recommended 
pivot table is as close 
as you will get to the 
required report.        

Figure I.5  
 To finish the report, drag 
the Product heading to 
the Columns area.        
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  Sample Files Used in This Book  
All data files used throughout this book are available for download from  www.mrexcel.com/
pivotbookdata2016.html . You will find one Excel workbook per chapter and should be able 
to achieve exactly the same results shown in the figures in this book by starting with the raw 
data on the Data worksheet. If you simply want to work with the final pivot table, you can 
find it in the workbook as well.   

  Conventions Used in This Book  
This book follows certain conventions:  

    ■    Monospace —Code and messages you see onscreen appear in a monospace font.   

   ■    Bold —   Text you type appears in a bold font.   

   5.   Unselect Field Headers on the right side of the ribbon.    

 With just five clicks of the mouse, you have the report shown in  Figure   I.6   .   

 In addition, when your manager comes back with a request like the ones near the end of the prior case study, you can 

easily use the pivot table makes to make the changes. Here’s a quick overview of the changes you’ll learn to make in the 

chapters that follow:  

    ■   Could you put products down the side and regions across the top? (This change will take you 10 seconds: Drag 

Product to Rows and Region to Columns.)   

 ■   Could you show me the same report for only the manufacturing customers? (15 seconds: Select Insert Slicer, Sector; 

click OK; click Manufacturing.)   

 ■   Could you show profit instead of revenue? (10 seconds: Uncheck Revenue, check Profit.)   

   ■   Could you copy this report for each of the customers? (30 seconds: Move Customer to Report Filter, open the tiny 

drop-down next to the Options button, choose Show Report Filter Pages, click OK.)    

Figure I.6  
 It took five clicks to create 
this report.        

http://www.mrexcel.com/pivotbookdata2016.html
http://www.mrexcel.com/pivotbookdata2016.html
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 ■    Italic —   New and important terms appear in italics.   

 ■   Initial Caps—Tab names, dialog names, and dialog elements are presented with initial 
capital letters so you can identify them easily.      

  Referring to Ribbon Commands  
When the active cell is inside a pivot table, two new tabs appear on the ribbon. In the 
help files, Microsoft calls these tabs “PivotTable Tools | Analyze” and “PivotTable Tools 
| Design.” For convenience, this book refers to these elements as the Analyze tab and the 
Design tab, respectively. The Slicer feature has a ribbon tab that Microsoft calls “Slicer 
Tools | Options.” This book refers to this as the Slicer tab. Excel 2013 introduced the 
“Timeline Tools | Options” tab. This book calls this the Timeline tab.  

In some cases, the ribbon icon leads to a drop-down with additional choices. In these cases, 
the book lists the hierarchy of ribbon, icon, menu choice, and submenu choice. For exam-
ple,  Figure   I.7    shows what you would select if the book said “select Design, Report Layout, 
Repeat All Item Labels.”    

Figure I.7  
 For shorthand, instruc-
tions might say to select 
Design, Report Layout, 
Repeat All Item Labels.        

  Special Elements  
This book contains the following special elements:    

 Case studies provide real-world examples involving topics previously introduced in the chapter.   

  C A S E  S T U D Y  
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 Notes provide additional information outside the main thread of the chapter discussion that might be 

useful for you to know.   

  N
O

T
E 

 Tips provide quick workarounds and time-saving techniques to help you do your work more efficiently.   
  T

IP
 

 Cautions warn you about potential pitfalls you might encounter. Pay attention to cautions because 

they alert you to problems that could cause you hours of frustration.       

  C A U T I O N 



 Pivot Table Fundamentals  

  Defining a Pivot Table  
Imagine that Excel is a large toolbox that contains 
different tools at your disposal. The pivot table is 
essentially one tool in your Excel toolbox. If a pivot 
table were indeed a physical tool that you could hold 
in your hand, a kaleidoscope would most  accurately 
represent it.  

When you look through a kaleidoscope at an object, 
you see that object in a different way. You can turn 
the kaleidoscope to move around the details of the 
object. The object itself doesn’t change, and it’s not 
connected to the kaleidoscope. The kaleidoscope is 
simply a tool you use to create a unique perspective 
on an ordinary object.  

Think of a pivot table as a kaleidoscope that is 
pointed at a data set. When you look at a data 
set through a pivot table, you have the opportu-
nity to see details in the data that you might not 
have noticed before. Furthermore, you can turn 
your pivot table to see your data from different 
perspectives. The data set itself doesn’t change, 
and it’s not connected to the pivot table. The pivot 
table is simply a tool you use to create a unique 
perspective on your data.  

A pivot table enables you to create an interactive 
view of your data set, called a  pivot table report . With 
a pivot table report, you can quickly and easily 
categorize your data into groups, summarize large 
amounts of data into meaningful information, and 
perform a variety of calculations in a fraction of the 
time it takes by hand. But the real power of a pivot 
table report is that you can use it to interactively 
drag and drop fields within your report, dynamically 
change your perspective, and recalculate totals to fit 
your current view.   

   Defining a Pivot Table ....................................    9   

   Why You Should Use a Pivot Table .................    10   

   When to Use a Pivot Table ............................    12   

   Anatomy of a Pivot Table ..............................    12   

   Pivot Tables Behind the Scenes .....................    14   

   Pivot Table Backward Compatibility ..............    15      

     I N  T H I S  C H A P T E R 
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  Why You Should Use a Pivot Table  
As a rule, what you do in Excel can be split into two categories:  

    ■   Calculating data   

   ■   Shaping (formatting) data    

Although many built-in tools and formulas facilitate both of these tasks, using a pivot table 
is often the fastest and most efficient way to calculate and shape data. Let’s look at one 
simple scenario that illustrates this point.  

 You have just given your manager some revenue information by month, and he has predict-
ably asked for more information. He adds a note to the worksheet and emails it back to you. 
As you can see in  Figure   1.1   , he would like you to add a line that shows credits by month.   

 

Figure 1.1  
 Your manager predictably 
changes his request after 
you provide the first pass 
of a report.        

To meet this new requirement, you run a query from your legacy system that provides 
the needed data. As usual, the data is formatted specifically to make you suffer. Instead of 
data by month, the legacy system provides detailed transactional data by day, as shown in 
Figure   1.2   .   

 

Figure 1.2  
 The data from the legacy 
system is by day instead 
of by month.        

Your challenge is to calculate the total dollar amount of credits by month and shape the 
results into an extract that fits the format of the original report. The final extract should 
look like the data shown in  Figure   1.3   .   
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Creating the extract manually would take 18 mouse clicks and 3 keystrokes:  

    ■   Format dates to month: 3 clicks   

   ■   Create subtotals: 4 clicks   

   ■   Extract subtotals: 6 clicks, 3 keystrokes   

   ■   Transpose vertical to horizontal: 5 clicks    

 In contrast, creating the extract with a pivot table would take 9 mouse clicks:  

    ■   Create the pivot table report: 5 clicks   

   ■   Group dates into months: 3 clicks   

   ■   Transpose vertical to horizontal: 1 click    

 Both methods give you the same extract, which you can paste into the final report, as shown 
in  Figure   1.4   .   

 Figure 1.3  
 Your goal is to produce a 
summary by month and 
transpose the data to a 
horizontal format.        

Figure 1.4  
 After adding credits 
to the report, you can 
 calculate net revenue.        

  Advantages of Using a Pivot Table  
Using a pivot table to accomplish the task just described not only cuts down the number of 
actions by more than half but also reduces the possibility of human error. In addition, using 
a pivot table allows for the quick-and-easy shaping and formatting of the data.  

This example shows that using a pivot table is not just about calculating and summarizing 
your data. Pivot tables can often help you do a number of tasks faster and better than con-
ventional functions and formulas. For example, you can use pivot tables to instantly trans-
pose large groups of data vertically or horizontally. You can use pivot tables to quickly find 
and count the unique values in your data. You can also use pivot tables to prepare your data 
to be used in charts.  

The bottom line is that pivot tables can help you dramatically increase your efficiency and 
decrease your errors on a number of tasks you might have to accomplish with Excel. Pivot 
tables can’t do everything for you, but knowing how to use just the basics of pivot table 
functionality can take your data analysis and productivity to a new level.    
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  When to Use a Pivot Table  
Large data sets, ever-changing impromptu data requests, and multilayered reporting are 
absolute productivity killers if you have to tackle them by hand. Going into hand-to-hand 
combat with one of these not only is time-consuming, but also opens up the possibility of 
an untold number of errors in your analysis. So how do you recognize when to use a pivot 
table before it’s too late?  

Generally, a pivot table would serve you well in any of the following situations:  

    ■   You have a large amount of transactional data that has become increasingly difficult to 
analyze and summarize in a meaningful way.   

   ■   You need to find relationships and groupings within your data.   

   ■   You need to find a list of unique values for one field in your data.   

   ■   You need to find data trends using various time periods.   

   ■   You anticipate frequent requests for changes to your data analysis.   

   ■   You need to create subtotals that frequently include new additions.   

   ■   You need to organize your data into a format that’s easy to chart.     

  Anatomy of a Pivot Table  
Because the anatomy of a pivot table is what gives it its flexibility and, indeed, its ultimate 
functionality, truly understanding pivot tables would be difficult without understanding 
their basic structure.  

A pivot table is composed of four areas:  

    ■   Values area   

   ■   Rows area   

   ■   Columns area   

   ■   Filters area    

 The data you place in these areas defines both the utility and appearance of the pivot table.  

 You will go through the process of creating a pivot table in the next chapter, and the follow-
ing sections prepare you for that by taking a closer look at the four pivot table areas and the 
functionality around them.  

  Values Area  
The  values area  is shown in  Figure   1.5   . It is a large rectangular area below and to the right 
of the headings. In this example, the values area contains a sum of the revenue field.   
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The values area is the area that calculates. This area is required to include at least one 
field and one calculation on that field. The data fields you drop here are those you want to 
measure or calculate. The values area might include Sum of Revenue, Count of Units, and 
Average of Price.  

It is also possible to have the same field dropped in the values area twice but with differ-
ent calculations. For example, a marketing manager might want to see Minimum of Price, 
Average Price, and Maximum of Price.   

  Rows Area  
The  rows area , as shown in  Figure   1.6   , is composed of the headings that go down the left 
side of the pivot table.   

Figure 1.5  
 The heart of the pivot 
table is the values 
area. This area typically 
includes a total of one or 
more numeric fields.        

Figure 1.6  
 The headings down the 
left side of the pivot table 
make up the rows area of 
the pivot table.        

Dropping a field into the rows area displays the unique values from that field down the 
rows of the left side of the pivot table. The rows area typically has at least one field, 
although it is possible to have no fields. The example earlier in the chapter where you 
needed to produce a one-line report of credits is an example where there are no row fields.  

The types of data fields you would drop here include those you want to group and catego-
rize—for example, Products, Names, and Locations.   
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Dropping fields into the columns area would display your items in column-oriented per-
spective. The columns area is ideal for showing trending over time. The types of data fields 
you would drop here include those you want to trend or show side by side—for example, 
Months, Periods, and Years.   

  Filters Area  
The  filters area  is an optional set of one or more drop-downs at the top of the pivot table. In 
Figure   1.8   , the filters area contains the Region field and the pivot table is set to show all regions.   

  Columns Area  
The  columns area  is composed of headings that stretch across the top of columns in the 
pivot table. In the pivot table in  Figure   1.7   , the Month field is in the columns area.   

Figure 1.7  
 The columns area 
stretches across the top 
of the columns. In this 
example, it contains the 
unique list of months in 
your data set.        

Figure 1.8  
 Filter fields are great for 
quickly filtering a report. 
The Region drop-down 
in cell B1 enables you 
to print this report for 
one particular region 
manager.        

Dropping fields into the filters area would enable you to filter the data items in your fields. 
The filters area is optional and comes in handy when you need to filter your results dynam-
ically. The types of data fields you would drop here include those you want to isolate and 
focus on—for example, Regions, Line of Business, and Employees.    

  Pivot Tables Behind the Scenes  
It’s important to know that pivot tables come with a few file space and memory implications 
for your system. To get an idea of what this means, let’s look at what happens behind the 
scenes when you create a pivot table.  
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The benefit of working against the pivot cache and not your original data source is optimi-
zation. Any changes you make to the pivot table report, such as rearranging fields, adding 
new fields, or hiding items, are made rapidly and with minimal overhead.   

  Pivot Table Backward Compatibility  
With Excel 2007, Microsoft introduced a dramatic increase in the number of rows and col-
umns allowed in one worksheet. This increase in limits led to the creation of a new Excel 
file type: .xlsx. The.xlsx file type not only allows for more rows and columns than the legacy 
.xls files (used by Excel 2003 and prior versions), but also comes with limitation increases in 
many areas, including pivot tables.  

Table   1.1    highlights the pivot table limits in both .xls and .xlsx file types. Whereas some of 
these limitations remain constant, others are highly dependent on available system memory.   

 When you initiate the creation of a pivot table report, Excel takes a snapshot of your data 
set and stores it in a  pivot cache , which is a special memory subsystem where your data 
source is duplicated for quick access. Although the pivot cache is not a physical object you 
can see, you can think of it as a container that stores a snapshot of the data source.   

 Any changes you make to your data source are not picked up by your pivot table report until you take 

another snapshot of the data source or “refresh” the pivot cache. Refreshing is easy: Simply right-click 

the pivot table and click Refresh Data. You can also click the large Refresh button on the Options tab.  

 C A U T I O N 

Table 1.1   Pivot Table Limitations  

Category     .xls Files     .xlsx Files   

Number of row fields   Limited by available memory   1,048,576 (could be limited by 
available memory)  

 Number of column fields   256   16,384  

 Number of page fields   256   16,384  

 Number of data fields   256   16,384  

 Number of unique items in a 
single pivot field  

 32,500   1,048,576 (could be limited by 
available memory)  

 Number of calculated items   Limited by available memory   Limited by available memory  

 Number of pivot table reports 
on one worksheet  

 Limited by available memory   Limited by available memory  



1

16 Chapter 1              Pivot Table Fundamentals

  A Word About Compatibility  
As you can imagine, the extraordinary increases in pivot table limitations lead to some seri-
ous compatibility questions. For instance, what if you create a pivot table that contains 
more than 256 column fields and more than 32,500 unique data items? How are users with 
previous versions of Excel affected by this? Luckily, Excel allows for some precautionary 
measures that can help you avoid compatibility issues.  

The first precautionary measure is Compatibility mode. Compatibility mode is a state 
that Excel automatically enters when opening an .xls file. When Excel is in Compatibility 
mode, it artificially takes on the limitations of Excel 2003. This means that while you are  
working with an .xls file, you cannot exceed any of the .xls file pivot table limitations shown 
in  Table   1.1   . This effectively prevents you from unwittingly creating a pivot table that is 
not compatible with previous versions of Excel. If you want to get out of Compatibility 
mode, you have to save the .xls file as one of  Excel’s newer .xlsx or .xslm file formats (.xlsm 
files are macro-enabled Excel files).   

 Beware of the Convert option found under the Info section of the File menu. Although this command 

is designed to convert a previous file from Excel 2003 to Excel 2013, it actually deletes the Excel 2003 

copy of the file.  

 C A U T I O N 

The second precautionary measure is Excel’s Compatibility Checker. The Compatibility 
Checker is a built-in tool that checks for any compatibility issues when you try to save an 
Excel workbook as an .xls file. If your pivot table exceeds the bounds of .xls file limitations, 
the Compatibility Checker alerts you with a dialog similar to the one shown in  Figure   1.9   .   

Figure 1.9  
 The Compatibility Checker 
alerts you about any 
compatibility issues 
before you save to a pre-
vious version of Excel.        

With this dialog, Excel gives you the option of saving your pivot data as hard values in the 
new .xls file. If you choose to do so, the data from your pivot table is saved as hard values, 
but the pivot table object and the pivot cache are lost.         
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  Next Steps  
In the next chapter, you’ll learn how to prepare your data to be used by a pivot table. 
Chapter   2   , “Creating a Basic Pivot Table,” also walks through creating your first pivot table 
report using the Pivot Table Wizard.     

 For information on Excel’s compatibility tools, pick up Que Publishing’s  Special Edition Using Microsoft 

Excel 2016 , by Bill Jelen.  

 N
O

T
E 
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 As you read the following pages, which discuss preparing your data, 

keep in mind that pivot tables have only one hard rule pertaining to 

the data source: The data source must have column headings, which 

are labels in the first row of the data that describe the information 

in each column. Without column headings, you cannot create a pivot 

table report.  

 T
IP

 

However, just because a pivot table report is created 
successfully does not mean that it’s effective. A host 
of things can go wrong as a result of bad data prepa-
ration—from inaccurate reporting to problems with 
grouping and sorting.  

Let’s look at a few of the steps you can take to ensure 
that you end up with a viable pivot table report.  
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  Ensuring That Data Is in a Tabular Layout  
A perfect layout for the source data in a pivot table is a tabular layout. In tabular layout, 
there are no blank rows or columns. Every column has a heading. Every field has a value in 
every row. Columns do not contain repeating groups of data.  

Figure   2.1    shows an example of data structured properly for a pivot table. There are head-
ings for each column. Even though the values in D2:D6 are all the same model, the model 
number appears in each cell. Month data is organized down the page instead of across the 
columns.   

Figure 2.1  
 This data is structured 
properly for use as a pivot 
table source.        

Tabular layouts are  database centric , meaning you would most commonly find these types of 
layouts in databases. These layouts are designed to store and maintain large amounts of data 
in a well-structured, scalable format.    

 You might work for a manager who demands that the column labels be split into two rows. For 

example, he might want the heading Gross Margin to be split, with Gross in row 1 and Margin in row 2. 

Because pivot tables require a unique heading one row high, your manager’s preference can be 

 problematic. To overcome this problem, start typing your heading; for example, type  Gross . Before 

leaving the cell, press Alt+Enter and then type  Margin . The result is a single cell that contains two 

lines of data.  

 T
IP

 

  Avoiding Storing Data in Section Headings  
Examine the data in  Figure   2.2   . This spreadsheet shows a report of sales by month and 
model for the North region of a company. Because the data in rows 2 through 24 pertains 
to the North region, the author of the worksheet entered the title North as a single cell in 
C1. This approach is effective for display of the data, but it’s not effective for a pivot table 
data source.   
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Also in  Figure   2.2   , the author was very creative with the model information. The data in 
rows 2 through 6 applies to Model 2500P, so the author entered this value once in A2 and 
then applied a fancy vertical format combined with Merge Cells to create an interesting 
look for the report. Again, although this is a cool format, it is not useful for pivot table 
reporting.  

Also, the worksheet in  Figure   2.2    is missing column headings. You can guess that column A 
is Model, column B is Month, and column C is Sales, but for Excel to create a pivot table, 
this information must be included in the first row of the data.   

  Avoiding Repeating Groups as Columns  
The format shown in  Figure   2.3    is common. A time dimension is presented across several 
columns. Although it is possible to create a pivot table from this data, this format is not ideal.   

Figure 2.2  
 Region and model data 
are not formatted prop-
erly in this data set.        

Figure 2.3  
 This matrix format is 
common but not effec-
tive for pivot tables. The 
Month field is spread 
across several columns of 
the report.        

The problem is that the headings spread across the top of the table pull double duty as col-
umn labels and actual data values. In a pivot table, this format would force you to manage 
and maintain six fields, each representing a different month.   
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  Eliminating Gaps and Blank Cells in the Data Source  
Delete all empty columns within your data source. An empty column in the middle of your 
data source causes your pivot table to fail on creation because the blank column, in most 
cases, does not have a column name.  

Delete all empty rows within your data source. Empty rows may cause you to inadvertently 
leave out a large portion of your data range, making your pivot table report incomplete.  

Fill in as many blank cells in your data source as possible. Although filling in cells is not 
required to create a workable pivot table, blank cells are generally errors waiting to hap-
pen. So a good practice is to represent missing values with some logical missing value code 
wherever possible.   

 Although eliminating gaps and blank cells might seem like a step backward for those of you who are 

trying to create a nicely formatted report, it pays off in the end. When you are able to create a pivot 

table, there will be plenty of opportunities to apply some pleasant formatting.   

 N
O

T
E 

   Applying Appropriate Type Formatting to Fields  
Formatting fields appropriately helps you avoid a whole host of possible issues, from inac-
curate reporting to problems with grouping and sorting.  

Make certain that any fields to be used in calculations are explicitly formatted as a number, 
currency, or any other format appropriate for use in mathematical functions. Fields contain-
ing dates should also be formatted as any one of the available date formats.   

  Summary of Good Data Source Design  
The attributes of an effective tabular design are as follows:  

    ■   The first row of your data source is made up of field labels or headings that describe 
the information in each column.   

   ■   Each column in your data source represents a unique category of data.   

   ■   Each row in your data source represents individual items in each column.   

   ■   None of the column names in your data source double as data items that will be used 
as filters or query criteria (that is, names of months, dates, years, names of locations, or 
names of employees).         

    In  Chapter   3   , “Customizing a Pivot Table,” you’ll discover how to apply styles formatting to your pivot 

tables.   N
O

T
E
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 The worksheet shown in  Figure   2.4    is a great-looking report. However, it cannot be effectively used as a data source for a 

pivot table. Can you identify the problems with this data set?   

 These are the four problems with the data set and the fixes needed to get the data set pivot table ready:  

 ■   The model information does not have its own column. Product category information appears in the Region column. 

To correct this problem, insert a new column titled Product Category and include the category name on every row.   

 ■   There are blank columns and rows in the data. Column C should be deleted. The blank rows between models (such 

as rows 8 and 15) also should be deleted.   

 ■   Blank cells present the data in an outline format. The person reading this worksheet would probably assume that 

cells A4:A5 fall into the Midwest region. These blank cells need to be filled in with the values from above.    

 ■   The worksheet presents the data for each month in several columns (one column per month). Columns D through G 

need to be reformatted as two columns. Place the month name in one column and the units for that month in the 

next column. This step either requires a fair amount of copying and pasting or a few lines of VBA macro code.     

 C A S E  S T U D Y :  C L E A N I N G  U P  D A T A  F O R  P I V O T  T A B L E  A N A L Y S I S  

Figure 2.4  
 Someone spent a lot 
of time formatting this 
report to look good, but 
what problems prevent it 
from being used as a data 
source for a pivot table?        

 Here’s a trick for filling in the blank cells. Select the entire range of data. Then select the Home tab on 

the ribbon and choose the Find & Select icon from the Editing group. This brings up a menu from which 

you select Go To Special. In the Go To Special dialog, select Blanks. With all the blank cells selected, 

start a formula by typing the equal sign (=), press the up arrow on your keyboard, and then press 

Ctrl+Enter to fill this formula in all blank cells. Remember to select the entire range of data again and 

copy/paste special  values in order to convert the formulas to values.  

 T
IP

 

2



24 Chapter 2              Creating a Basic Pivot Table

  How to Create a Basic Pivot Table  
Now that you have a good understanding of the importance of a well-structured data 
source, let’s walk through creating a basic pivot table.   

 After you make the four changes described here, the data is ready for use as a pivot table data source. As you can see in 

 Figure   2.5   , each column has a heading. There are no blank cells, rows, or columns in the data. The monthly data is now 

presented down column E instead of across several columns.   

 For a great book on learning VBA macro programming, read Que Publishing’s  VBA and Macros for 

Microsoft Excel 2016  by Bill Jelen and Tracy Syrstad.  

 T
IP

 

Figure 2.5  
 Although this data will 
take up six times as 
many rows, it is perfectly 
formatted for pivot table 
analysis.        

 The sample data set used throughout this book is available for download at  www.mrexcel.com/

pivotbookdata2016.html .  

 N
O

T
E 

To ensure that the pivot table captures the range of your data source by default, click any 
single cell in your data source. Next, select the Insert tab and find the Tables group. In 
the Tables group, select PivotTable and then choose PivotTable from the drop-down list. 
Figure   2.6    demonstrates how to start a pivot table.   

Figure 2.6  
 Start a pivot table by 
selecting PivotTable from 
the Insert tab.        

2

http://www.mrexcel.com/pivotbookdata2016.html
http://www.mrexcel.com/pivotbookdata2016.html
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As you can see in  Figure   2.7   , the Create PivotTable dialog asks you only two fundamental 
questions: Where’s the data that you want to analyze? and Where do you want to put the 
pivot table? Here’s how you handle these two sections of the dialog:  

    ■    Choose the Data That You Want to Analyze —   In this section, you tell Excel where 
your data set is. You can specify a data set that is located within your workbook, or you 
can tell Excel to look for an external data set. As you can see in  Figure   2.7   , Excel is smart 
enough to read your data set and fill in the range for you. However, you always should 
take note of the range Excel selects to ensure that you are capturing all your data.   

   ■    Choose Where You Want the PivotTable Report to Be Placed —   In this sec-
tion, you tell Excel where you want your pivot table to be placed. This is set to New 
Worksheet by default, meaning that your pivot table will be placed in a new worksheet 
within the current workbook. You will rarely change this setting because there are rela-
tively few times you’ll need your pivot table to be placed in a specific location.     

Choosing these options activates the Create PivotTable dialog, shown in  Figure   2.7   .    

Figure 2.7  
 The Create PivotTable 
dialog.        

 You can also press the shortcut Alt+N+V to start a pivot table.  

 T
IP

 

 Note the presence of another option in the Create PivotTable dialog shown in  Figure   2.7   : the Add This 

Data to the Data Model option. You would select this option if you were trying to consolidate multiple 

data sources into one single pivot table.  

 The Add This Data to the Data Model option is covered this option in detail in  Chapter   7   , “Analyzing 

Disparate Data Sources with Pivot Tables,” and in  Chapter   10   , “Mashing Up Data with Power Pivot.”  

 In this chapter, we’ll keep it basic by covering the steps to create a pivot table from using a single 

source, which means you can ignore this particular option.  

 N
O

T
E 
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After you have answered the two questions in the Create PivotTable dialog, simply click the 
OK button. At this point, Excel adds a new worksheet that contains an empty pivot table 
report. Next to that is the PivotTable Fields list, shown in  Figure   2.8   . This pane helps you 
build your pivot table.      

Figure 2.8  
 You use the PivotTable 
Fields list to build a pivot 
table.        

 The PivotTable Fields list is your main work area in Excel 2016. This is the place where you add fields and make changes 

to a pivot table report. By default, this pane pops up when you place your cursor anywhere inside a pivot table. However, 

if you explicitly close this pane, you override the default and essentially tell the pane not to activate when you are in the 

pivot table.  

 If clicking on the pivot table does not activate the PivotTable Fields list, you can manually activate it by right-clicking 

anywhere inside the pivot table and selecting Show Fields list. You can also click anywhere inside the pivot table and then 

choose the large Fields List icon on the Analyze tab under PivotTable Tools in the ribbon.  

 F I N D I N G  T H E  P I V O T T A B L E  F I E L D S  L I S T  

  Adding Fields to a Report  
You can add the fields you need to a pivot table by using the four “areas” found in the 
PivotTable Fields list: Filters, Columns, Rows, and Values. These areas, which correspond 
to the four areas of the pivot table, are used to populate your pivot table with data:   

    Review  Chapter   1   , “Pivot Table Fundamentals,” for a refresher on the four areas of a pivot table.   

N
O

T
E
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 ■    Filters —   Adding a field to the Filters area enables you to filter on its unique data items. 
In previous versions of Excel, this area was known as the Report Filters area.   

   ■    Columns —   Adding a field into the Columns area displays the unique values from that 
field across the top of the pivot table.   

   ■    Rows —   Adding a field into the Rows area displays the unique values from that field 
down the left side of the pivot table.   

   ■    Values —   Adding a field into the Values area includes that field in the values area of your 
pivot table, allowing you to perform a specified calculation using the values in the field.     

  Fundamentals of Laying Out a Pivot Table Report  
Now let’s pause a moment and go over some fundamentals of laying out a pivot table 
report. This is generally the point where most new users get stuck. How do you know 
which field goes where?  

Before you start dropping fields into the various areas, answer two questions: “What am 
I measuring?” and “How do I want to see it?” The answer to the first question tells you 
which fields in your data source you need to work with, and the answer to the second ques-
tion tells you where to place the fields.  

Say that in this case, you want to measure the dollar sales by region. This automatically tells 
you that you need to work with the Sale Amount field and the Region field. How do you 
want to see it? You want regions to go down the left side of the report and the sales amount 
to be calculated next to each region.  

To achieve this effect, you need to add the Region field to the Rows area and add the Sale 
Amount field to the Values area.  

Find the Region field in the PivotTable Fields list, and place a check in the check box next 
to it. As you can see in  Figure   2.9   , not only is the field automatically added to the Rows 
area, but your pivot table is updated to show the unique region names.   

Figure 2.9  
 Place a check next to 
the Region field to auto-
matically add that field to 
your pivot table.        
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Now that you have regions in your pivot table, it’s time to add in the dollar sales. To do 
that, simply find the Sale Amount field and place a check next to it. As  Figure   2.10    illus-
trates, the Sale Amount field is automatically added to the Values area, and your pivot table 
report now shows the total dollar sales for each region.   

 At this point, you have already created your first pivot table report!       

Figure 2.10  
 Place a check next to the 
Sale Amount field to add 
data to your pivot table 
report.        

 As you’ve just experienced, the PivotTable Fields list interface enables you to add fields to your pivot table by simply plac-

ing a check next to each field name. Excel automatically adds the checked fields to the pivot table. But how does Excel 

know which area to use for a field you check? The answer is that Excel doesn’t really know which area to use, but it makes 

a decision based on data type. Here’s how it works: When you place a check next to a field, Excel evaluates the data type 

for that field. If the data type is numeric,  Excel places the field into the Values area; otherwise, Excel places the field into 

the Rows area. This placement obviously underlines the importance of correctly assigning the data types for your fields.  

 H O W  D O E S  E X C E L  K N O W  W H E R E  Y O U R  F I E L D S  G O ?  

 Watch out for blanks in your numeric fields. If you have even one blank cell in a numeric field, Excel 

reads that cell as a Text field and therefore places it in the Rows area!  

 C A U T I O N 

  Adding Layers to a Pivot Table  
Now you can add another layer of analysis to your report. Say that now you want to mea-
sure the amount of dollar sales each region earned by product category. Because your pivot 
table already contains the Region and Sales Amount fields, all you have to do is place a 


